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Visão Geral

Design modular 
O sistema Access Professional Edition (mencionado aqui como
Access PE) fornece controle de acesso autônomo para
pequenas e médias empresas. Ele consiste em vários módulos:
– LAC Service: um processo em constante comunicação com

os LACs (Controladores de Acessos Locais – denominados
a partir de agora como Controladores). Os AMCs
(Controladores Modulares de Acesso) são usados como
Controladores.

– Configurador
– Gerenciamento de funcionários
– Visualizador do histórico
– Gerenciamento de alarmes
– Verificação por vídeo

Módulos de servidor e cliente
Os módulos podem ser divididos em módulos de servidor e
módulos de cliente.
O LAC Service necessita permanecer em contato constante com
os controladores, em primeiro lugar, porque está
constantemente recebendo mensagens destes relativas a
movimentos, presença e ausência de usuários de cartões e, em
segundo lugar, porque transmite aos controladores alterações
aos dados, p. ex., atribuição de novos cartões, mas sobretudo
porque efetua verificações de metanível (verificações das
sequências de acesso, verificações de antirretorno, revista
aleatória).
O Configurador também deve ser executado no servidor, no
entanto, pode ser instalado em estações de trabalho de clientes
e operado a partir delas.
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Os módulos Gerenciamento de funcionários e Visualizador do
histórico pertencem ao componente de Cliente e também
podem ser executados no Servidor ou em outro PC com uma
conexão de rede ao servidor.
Os seguintes Controladores podem ser usados.
– AMC2 4W (com quatro interfaces de leitor Wiegand) - pode

ser ampliado com uma AMC2 4W-EXT
– AMC2 4R4 (com quatro interfaces de leitor RS485)
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Geral

Introdução
O Access PE é um sistema de controle de acesso concebido
para oferecer os mais elevados padrões de segurança e
flexibilidade em instalações de pequeno e médio porte.
O Access PE deve a sua estabilidade e possibilidade de
atualização a um projeto de três camadas: a primeira camada é
a de administração com os seus serviços de controle. Todas as
tarefas administrativas são aqui executadas, por ex., o registro
de novos cartões e a atribuição de direitos de acesso.
A segunda camada é formada pelos controladores de acessos
locais (LACs) que controlam cada grupo de portas e entradas.
Mesmo quando o sistema está offline, um LAC é capaz, de forma
independente, de tomar decisões de controle de acesso. Os
LACs são responsáveis pelo controle das entradas e dos tempos
de abertura da porta ou pela solicitação de códigos PIN em
pontos de acesso críticos.
A terceira camada consiste em leitores de cartão.
A comunicação entre cliente, servidor e usuários de cartões é
criptografada por AES.
A versão multi-usuário do Access PE permite que várias estações
de trabalho controlem o sistema. Os níveis de direitos do
usuário configuráveis restringem o acesso e garantem a
segurança. Desta forma, é possível, por exemplo, manter os
dados do cartão a partir de uma estação de trabalho enquanto
usa outra para verificar se um funcionário se encontra no
edifício
O Access PE oferece uma configuração excepcionalmente
flexível dos direitos de acesso, modelos de tempo e dos
parâmetros de entrada. A seguinte lista fornece uma visão geral
das características mais importantes:
Atribuição fácil e rápida de cartões
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Os cartões (até três) podem ser atribuídos a pessoas
manualmente ou usando um leitor de cadastramento conectado
a um PC por meio de uma conexão serial. Todos os cartões
atribuídos estão ativos. Na atualização dos cartões, o cartão
antigo é automaticamente substituído e torna-se inválido,
evitando assim que cartões antigos tenham acesso, mesmo que
os responsáveis os tenham esquecido ou não tenham
conseguido cancelá-los.
Direitos de Acesso (incluindo Privilégios do Grupo)
Cada pessoa pode herdar privilégios do grupo, bem como ter
direitos individuais atribuídos. Os privilégios podem ser restritos
por área e tempo com uma precisão de um minuto. Os
privilégios do grupo podem ser utilizados para conceder e
limitar os direitos de acesso para qualquer ou para todos os
usuários de cartão simultaneamente. Os privilégios do grupo
podem estar dependentes de modelos de tempo, o que
restringe o acesso em determinados períodos do dia.
Rastreamento de Acesso
Ao definir áreas é possível seguir e cumprir uma sequência
correta de acessos. Mesmo sem monitoração, esta configuração
torna possível exibir a localização do usuário do cartão.
Anti-Dupla Entrada
Quando um cartão for lido, pode ser bloqueada a sua entrada a
este mesmo ponto de acesso durante um período de tempo
definido. Assim, é possível evitar a "dupla entrada", em que um
usuário passa o seu cartão através de uma barreira para
proporcionar acesso a uma pessoa não autorizada.
Cancelamento Automático de Cartões em caso de Expiração
Visitantes e pessoal temporário necessitam frequentemente de
acesso apenas durante um período limitado.
Os cartões podem ser registrados para um período de tempo
específico, de modo a que percam automaticamente a sua
validade assim que esse período expire.
Modelos de Tempo e Modelos de Dia
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Modelos específicos de tempo podem ser atribuídos a um
usuário do cartão que regulam as horas que essa pessoa tem
acesso. Os modelos de tempo podem ser definidos de forma
flexível utilizando modelos de dia que determinam como é que
dias da semana específicos, fins de semana, feriados e dias
especiais diferem dos dias de trabalho normais.
Identificação através de Código PIN
Em vez de um cartão, uma pessoa pode usar um Código PIN
especial para entrar.
Verificação através de Código PIN
As áreas particularmente sensíveis podem ser programadas de
forma a exigirem Códigos PIN adicionais. Esta proteção pode,
por sua vez, ser dependente de modelos de tempo para que, por
exemplo, apenas seja necessário um Código PIN para o acesso
durante períodos de férias ou fora do período de expediente.
Flexível Gerenciamento da Porta
A parametrização flexível de modelos de porta individuais
permite um ótimo equilíbrio entre a segurança e o conforto. O
período de "shunt" ou de supressão de alarme pode ser
especificado individualmente para regular durante quanto
tempo uma porta deve permanecer aberta. Em cooperação com
um sistema de alarme, o ponto de acesso pode então ser
opcionalmente travado.
Desbloqueio Periódico da Porta
Para facilitar o acesso, os alarmes da porta podem ser
"shuntados" para desbloquear as portas durante períodos de
tempo específicos. Os períodos de desbloqueio da porta podem
ser definidos manual ou automaticamente através de um modelo
de tempo.
Apontamento de Frequência
Os pontos de acesso podem ser parametrizados para registrar a
entrada e saída para fins de apontamento de frequência.
Design do Cartão
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O módulo gráfico suplementar Card Personalization (CP)
(Personalização de Cartão) está completamente integrado no
sistema de controle de acesso para permitir ao operador criar
cartões sem mudar de aplicações.
Atribuição de Fotografias
Se o módulo suplementar Card Personalization (CP)
(Personalização de Cartão) não estiver ativado, a identificação
através de fotografia pode, apesar disso, ser realizada através
da importação da fotografia e respectiva associação aos
usuários de cartão.
Sistema de bloqueio offline
As áreas que, por algum motivo, não estão cobertas pela alta
disponibilidade do sistema de controle de acesso online,
podem, apesar disso, ser travadas offline.
Administração de dispositivos de vídeo
As entradas podem ser adicionalmente equipadas com câmeras
para identificar e seguir os movimentos das pessoas que as
estão utilizando.
 

Iniciar sessão (login) do usuário
Os seguintes aplicativos estão disponíveis. Consulte os
respectivos manuais do usuário para mais detalhes:

Gerenciamento de pessoal

Configurador

Visualizador do histórico

2.2
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Gerenciamento de Mapas e Alarmes

Verificação por vídeo

Aviso!

Só é possível fazer o login a partir do cliente se o serviço LAC

estiver em execução no servidor.

Login do cliente
Os aplicativos do sistema estão protegidos contra uso não
autorizado. As senhas padrão no primeiro uso são:
– Nome de usuário: bosch
– Senha: bosch

Após a inserção do nome de usuário e senha, o botão Change
Password (Alterar senha) fica ativo.
Após três tentativas incorretas, será necessário aguardar um
momento antes de tentar fazer o login novamente. Isso vale para
os botões "Start the Application" (Iniciar o aplicativo) e "Change
Password" (Alterar senha).
A lista suspensa na parte superior pode ser usada para
selecionar o idioma de interação desejado. O idioma
predefinido é aquele que foi usado para instalar o aplicativo. Se
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houver uma mudança de usuário sem reiniciar o aplicativo, é
mantido o idioma anterior. Por este motivo, é possível que
apareça uma caixa de diálogo em um idioma indesejado. Para
evitar isto, volte e inicie a sessão do Access PE.
Os aplicativos do Access PE podem ser executados nos
seguintes idiomas:
– Inglês
– Alemão
– Francês
– Japonês
– Russo
– Polonês
– Chinês (PRC)
– Holandês
– Espanhol
– Português (Brasil)

Aviso!

Todas as opções, como nomes de dispositivos, rótulos,

modelos e esquemas de direitos dos usuários, são exibidas no

idioma em que tiverem sido inseridas. Igualmente, os botões e

rótulos controlados pelo sistema operacional podem ser

exibidos no idioma do sistema operacional.

Após clicar no botão Change Password (Alterar senha), insira
um novo nome de usuário e uma nova senha nesta caixa de
diálogo:
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Aviso!

Não se esqueça de alterar a senha!

O botão Start the application (Iniciar o aplicativo) verifica os
privilégios do usuário e, com base neles, inicia o aplicativo. Se o
sistema não conseguir autenticar o início de sessão, aparecerá a
seguinte mensagem de erro:Nome de usuário ou senha
incorretos!
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Layout do Visualizador do histórico

1 = Barra de menus - Contém todas as funções da caixa
de diálogo organizadas em menus.

2 = Barra de ferramentas - Contém as funções mais
importantes da caixa de diálogo na forma de botões
de ícone.

3 = Barra de título - Corresponde ao Windows padrão e
contém botões para minimizar e fechar a janela de
diálogo principal. O nome do usuário atual é
mostrado entre colchetes.

4 = Status do dispositivo - lista dos dispositivos
configurados e entradas juntamente com o respectivo
estado de conexão.

5 = Lista de mensagens - lista das mensagens recebidas
até o momento. A exibição pode ser modificada por
configurações de filtro específicas.

6 = Seleção de filtro - podem ser selecionados da caixa
de seleção filtros predefinidos e personalizados.

2.3
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7 = Ativação de alarme - aciona a ativação/desativação
de alarmes para mensagens. Uma mensagem
recebida pode ser acompanhada de um sinal
acústico.

8 = Barra de status - datas dos arquivos de histórico de
eventos abertos. Status do LAC Service.
Configurações de alarme.

Botões de ícone
As seguintes funções estão disponíveis para a avaliação do
histórico de eventos através de menus e botões de ícone.

Menu Função Botão de
ícone

Descrição

Arquivo Imprimir... Imprime as
mensagens exibidas
do histórico

Sair  Fecha o aplicativo
LogViewer.

Filtro Definição
de filtro

Abre a caixa de
diálogo de filtragem
de mensagens.

2.4
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Menu Função Botão de
ícone

Descrição

Modo
contínuo
ativado

Inicia a exibição
contínua de
mensagens. Este
ícone só está ativo
quando a função já
não está em execução
e o filtro de
mensagens está
configurado para o dia
atual.
Exibição contínua de
mensagens é a
configuração
predefinida.

Modo
contínuo
desativado

Pausa a apresentação
contínua de
mensagens. Este
ícone só está ativo
quando a exibição
contínua de
mensagens está em
execução.

Eventos do
dia anterior

Muda para as
mensagens do dia
anterior.

Eventos do
dia
seguinte

Muda para as
mensagens do dia
seguinte.

Ver Barra de
símbolos

 Oculta/Mostra a barra
de ferramentas.
Predefinido = ativado.
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Menu Função Botão de
ícone

Descrição

Barra de
status

 Oculta/Mostra a barra
de status.
Predefinido = ativado.

sem item de menu

   

   

? (Ajuda) Tópicos de
ajuda

Abre este arquivo de
ajuda.

Sobre o
LogViewer

 Abre a Ajuda Sobre o
LogViewer do Access
PE.
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Histórico de eventos
Todos os processos (incluindo, por exemplo, dados para início e
fim de sessão para usuários em uma estação de trabalho) no
sistema de controle de acesso Access PE são encaminhados
usando mensagens correspondentes e armazenados nos
históricos de eventos. É possível separar mensagens relativas à
segurança (mensagens de alarme) de itens puramente
informativos ao classificá-los. Isso simplifica a implementação
de qualquer outra medida necessária.
Para uma apresentação clara com a opção de filtrar mensagens
importantes e alertar usuários da caixa de diálogo, você pode
instalar e iniciar a caixa de diálogo Logviewer (Visualizador do
Histórico) em qualquer estação de trabalho, desde que os
direitos de usuário da pessoa que está conectada permitam
fazê-lo.
 

Lista de mensagens
A principal função do LogViewer (Visualizador do histórico) é a
exibição das mensagens registradas, tanto as atuais quanto as
anteriores.

Por predefinição, a exibição é constantemente atualizada com
as mensagens de entrada. Os botões de ícone relevantes
aparecem com os seguintes estados: .

3

3.1

Access Professional
Edition

Histórico de eventos | pt-BR 17

Bosch Access Systems GmbH 2017-08 | APE-UL | Log Viewer



Na inicialização do LogViewer (Visualizador do histórico), são
exibidas as mensagens do dia atual. As mensagens dos dias

anteriores podem ser exibidas usando o botão . Todos os
dias, é criado um arquivo de eventos com o formato do nome do
arquivo Msg<aaaammdd>.log no seguinte diretório C:\BOSCH
\Access Professional Edition\Data\MsgLog. Todos esses
arquivos podem ser exibidos no LogViewer (Visualizador do
histórico).
A lista de mensagens contém colunas com as seguintes
informações:

Coluna Descrição

(sem título) Representação simbólica da categoria
da mensagem como definida no
Configurator (Configurador).

(sem título) Identificação das mensagens para as
quais existe uma gravação de vídeo: 

Data Data e hora de quando a mensagem foi
criada.

LAC/PC Fonte da mensagem: nome do
controlador ou da estação de trabalho.

Reader/Login
(Leitor/Início de
sessão)

Fonte da mensagem se o controlador
tiver apenas encaminhado a mensagem.
Se a fonte for uma estação de trabalho,
então será usado o nome do usuário
dessa estação.

Location (Door)/
Program
(Localização
(Porta)/Programa)

Nome da entrada, sinal ou outra
instalação. Se for uma estação de
trabalho, então o nome usado será o do
aplicativo.
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Coluna Descrição

Nº Número da mensagem de acordo com a
lista dos textos do histórico de eventos
no Configurator (Configurador).

Mensagem Mensagem de texto como definida no
Configurator (Configurador).

Card-No. (Nº do
cartão)

Número do cartão (na medida em que
foi lido e reconhecido pelo sistema).

Sobrenome Sobrenome do usuário do cartão.

Nome Primeiro nome do usuário do cartão.

Company/Dept.
(Empresa/Depto.)

Empresa/Departamento do usuário do
cartão.

Local date (Datal
local)

Se o AMC estiver localizado em um
fuso horário diferente, a hora local de
criação da mensagem será exibida aqui.

A lista de mensagens pode ser personalizada como desejado.
Por exemplo, a ordem das colunas pode ser alterada arrastando
e soltando os cabeçalhos das colunas. Dessa forma, pode
destacar as colunas que considerar mais importantes.
Para encontrar as mensagens que mais interessam a você, a
visualização da lista permite classificar (alternando entre a
ordem crescente ou decrescente) clicando duas vezes em
qualquer cabeçalho da coluna.
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Aviso!

Dependendo dos direitos atribuídos ao usuário, as mensagens

exibidas serão mais ou menos limitadas. Para usuários

autorizados apenas a visualizar suas próprias mensagens, todas

as mensagens pertencentes a outras pessoas serão filtradas.

Para usuários que não estejam autorizados a visualizar

quaisquer dados pessoais, as quatro últimas colunas de

conteúdos aparecerão em branco.

 

Filtragem de mensagens
Para restringir a exibição das mensagens que correspondem a
critérios específicos, clique em Filter > Filter Definition (Filtro >

Definição do filtro) ou no botão de ícone  na barra de
ferramentas. Será exibida uma caixa de diálogo para selecionar
os critérios de filtragem.

 

3.2
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As mensagens podem ser filtradas de acordo com os seguintes
critérios:
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Critérios de
filtragem

Descrição Notas

Time period
from ... to...
(Período de
tempo de... a...)

Ao introduzir datas
aqui, é possível
restringir a exibição
para um determinado
período. A data atual
pode ser introduzida
como a mais recente.
Ao introduzir outras
datas de exibições de
eventos de datas
anteriores, é possível
alterar ou expandir os
dados já exibidos.

Uma vez que todos
os arquivos de
histórico de
eventos serão
lidos, não é
recomendável
especificar um
período muito
longo para a
exibição.
Dependendo do
tamanho dos
arquivos de
histórico de
eventos,
recomendamos, no
máximo, um mês
no total.

Nome A exibição pode ser
limitada a pessoas
cujos nomes
correspondam aos
critérios de filtragem.

Os filtros Name
(Nome),
Company/Dept.
(Empresa/Depto.)
e card devem ser
usados
individualmente e
não podem ser
combinados.

Company/Dept.
(Empresa/
Depto.)

A exibição pode ser
limitada a pessoas de
determinadas
empresas ou
departamentos.
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Critérios de
filtragem

Descrição Notas

card (cartão) A exibição pode ser
limitada a pessoas
cujos números de
cartão estejam
dentro de um
intervalo específico.
Por exemplo, todos
os números de cartão
que comecem por 6.

Entrances
(Entradas)

Limita a exibição das
mensagens
relacionadas com as
entradas
especificadas.

 

Messages
(Mensagens)

Limita a exibição de
determinados tipos
de mensagem.

 

Alarm siren
with .wav file
(Sirene de alarme
com
arquivo .wav)

As mensagens de
alarme podem ser
enfatizadas por meio
de um sinal acústico.
Qualquer arquivo de
áudio do sistema
pode ser selecionado
para acompanhar um
alarme.
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Aviso!

Um filtro permanecerá ativo somente enquanto o aplicativo

estiver em execução. As configurações predefinidas (por ex.,

dia atual, sem filtro) são restauradas assim que o LogViewer

(Visualizador do histórico) for reiniciado.

 

Salvar e recarregar filtros
Para não ser necessário redefinir os filtros cada vez que o
programa for reiniciado, o LogViewer (Visualizador do histórico)
permite a cada usuário armazenar e recarregar as configurações
de filtro preferidas.
Depois de definir as suas configurações de filtro pessoais, será
possível armazená-las clicando em Save... (Salvar) na parte
inferior da caixa de diálogo. Por predefinição, as configurações
de filtro com nome (<nome do arquivo>.flt) são armazenadas
em C:\BOSCH\Access Professional Edition\Data\Cfg

Para recarregar ou ativar configurações de filtro salvas,
selecione-as na caixa de seleção Filter (Filtro), no canto inferior
esquerdo.
Para verificar e/ou editar um filtro previamente definido,

carregue e abra-o clicando em  e em Load... (Carregar) na
caixa de diálogo Filter view (Visualização de filtros).
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Agora, as configurações de filtro carregadas podem ser
verificadas, modificadas e finalmente aplicadas no aplicativo em
execução, clicando em OK.
 

Ativar o modo de alarme
Clicando em Activate alarm (Ativar alarme) ou selecionando um
filtro salvo com ativação de alarme, a janela LogViewer
(Visualizador do histórico) é fechada e passa para o modo de
standby. Ela é exibida na bandeja do sistema com o ícone .
Passando o mouse o texto a seguir, é exibida a mensagem
Access PE: Wait for alarm (Access PE: Aguarde o alarme).
Clique duas vezes no ícone a qualquer momento para retornar a
janela de diálogo para o primeiro plano.

Aviso!

Enquanto o Alarm mode (Modo de alarme) estiver ativo, o

aplicativo não poderá ser fechado pelo botão x na barra de

título nem por File > Exit (Arquivo > Sair). Em vez disso, o

LogViewer (Visualizador do histórico) voltará para o modo de

standby.

Se uma mensagem for recebida, a janela principal voltará para o
primeiro plano.
Enquanto a caixa Sound Off (Som desligado) não estiver
marcada, o alarme de entrada também será acompanhado por
um sinal de áudio.

3.3
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Relatórios: Visualização da página
É possível definir filtros para limitar o conteúdo do relatório a
um subconjunto. Se nenhum filtro for definido, todos os dados
serão apresentados. O botão Procurar ativa a coleta de dados e
a sua exibição em uma janela de pré-visualização.

Aviso!

Ao alterar critérios de filtragem, é recomendável usar o botão

Limpar formulário para evitar uma filtragem não intencional e,

assim, equívocos nos relatórios.

Os arquivos de histórico de eventos abertos podem ser salvos
ou impressos. O item de menu File > Print (Arquivo > Imprimir)

ou o botão  permite abrir uma pré-visualização.

 

3.4
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Aviso!

Todos os arquivos de histórico de eventos abertos serão

impressos.

Feche todos os arquivos que não devem ser impressos ou

restrinja a seleção às mensagens importantes.

 
A visualização da página do relatório oferece ferramentas para
modificar e manipular a exibição:

Botão Significado Descrição

Exportar A lista pode ser exportada para
um arquivo para processamento
posterior. Estão disponíveis os
seguintes formatos:
Acrobat Portable Document
Format (PDF)
Valores Separados por Vírgulas
(CSV)

Imprimir Imprime o relatório por meio de
uma caixa de diálogo de
impressão que permite a
configuração de uma impressora
predefinida.

Selecionar
página

Os botões de seta levam para a
primeira página, página anterior,
página seguinte ou última página
do relatório. O controle também
mostra o número total de páginas
e a página onde se encontra neste
relatório.
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Botão Significado Descrição

Nº de
páginas

Solicita a página atual e o número
total de páginas.

Zoom A escala padrão de visualização
(100 %) pode ser alterada como
desejado.

Exportar listas
Pressione o botão  para abrir uma caixa de diálogo que definirá
os critérios de exportação.

O campo da lista de seleção Format (Formato) oferece os
formatos de saída .pdf (para encaminhar e arquivar resultados
específicos de procura) e .csv (para outros dados de
processamento).
Durante a exportação dos dados para um arquivo csv, estes
poderão sofrer um determinado processamento.
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Da mesma forma que pode introduzir um Delimiter
(Delimitador) e o modo de exportação (Mode), é possível
também excluir ou isolar da exportação Report and Page
sections (Seções do relatório e de páginas) (cabeçalhos de
colunas e detalhes da página) e Group sections (Seções do
grupo) (dados selecionados).
Você pode selecionar uma das seguintes opções como
Destination (Destino).
– Application (Aplicativo) — abre o arquivo usando o

aplicativo adequado. Este aplicativo deve estar instalado no
computador. Os arquivos pdf são abertos no Adobe Acrobat
Reader e os arquivos csv, no MS Excel.

– Disk file (Arquivo de disco) (predefinido) — abre uma caixa
de diálogo do Explorer para selecionar o diretório
necessário. É sugerido um nome para salvar o arquivo.

– Exchange folder (Pasta de intercâmbio) — o arquivo pode
ser diretamente enviado para um destinatário do MS
Outlook.
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– Lotus Domino Mail — o arquivo pode ser diretamente
enviado para um destinatário do Lotus Mail.

 

Reprodução de vídeo
Se uma câmera de vigilância tiver sido configurada para uma
entrada, todas as mensagens para essa entrada serão marcadas

com um  na caixa de diálogo do histórico de eventos.
Dependendo da configuração do dispositivo de vídeo, isso
significa que as sequências de vídeo da câmera de vigilância
selecionada estarão disponíveis e poderão ser reproduzidas,
começando no momento em que a mensagem for emitida.
Ao selecionar uma mensagem com câmera de identificação, o

botão  na barra de ferramentas será ativado. Pressione
este botão para abrir a caixa de diálogo Reprodução de vídeo.

Reprodução de vídeo
Ao abrir a caixa de diálogo Reprodução de vídeo, a reprodução
será iniciada, por padrão, 20 segundos antes da emissão do
alarme e encerrará após 120 segundos.

3.5
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Você pode configurar o ponto de início e a duração das
sequências definidas quando o alarme é emitido.
Notas sobre o funcionamento da caixa de diálogo:

Barra de progresso que mostra em que
ponto do período de tempo configurado
está a reprodução.

Campos ajustáveis para o início e o fim do
período de tempo da sequência de vídeo a
ser exibida.

As horas de início e fim definidas apenas
serão ativadas ao confirmá-las com o
pressionamento deste botão.

Reiniciará a sequência de vídeo após sua
interrupção com o botão de pausa, ou
reduzirá a velocidade de reprodução se o
modo rápido tiver sido ativado.

Modo rápido — avança rapidamente a
sequência de vídeo.

Pausa — interrompe a exibição — produz
uma imagem fixa.

Vai para o início da sequência e reinicia a
reprodução.

Vai para a hora de emissão do alarme para
o qual a gravação de vídeo foi aberta.
Nota: Isso apenas será possível se a hora
do alarme estiver dentro do intervalo
definido.

Fecha a caixa de diálogo Reprodução de
vídeo.
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Requisitos da UL 294
Recursos não avaliados pela UL:
– O Sistema de verificação de vídeo
– Visualizador de mapas e o gerenciamento de alarmes com

verificação por mapas e vídeo
– Aparelho de vídeo
– Criador de crachá
– O Delta 1200 Series
– Rosslare ARD-1200EM Series
– Controladores LAC
– Controladores LACi
– Controladores APC-AMC2-4R4CF

– Protocolo de interface do leitor BG 900
– Protocolo de interface do leitor L-BUS

– IDS do sistema de segurança - Armar/Desarmar
– Uso do elevador
– Textos
– Livro de registros
– Gerenciamento de funcionários e relatórios
– Uso do alarme contra roubo

Recursos avaliados pela UL:
– Leitores no formato Wiegand de 26 bits
– Controladores AMC2:

– APC-AMC2-4WCF
– API-AMC2-4WE
– API-AMC2-8IOE
– API-AMC2-16IOE

– APE-SW como equipamento de monitoramento
complementar

Os seguintes leitores de cartão de modelo Bosch foram
avaliados pela UL quanto à compatibilidade com o sistema do
software do APE-SW da Bosch:
– LECTUS secure 1000 WI
– LECTUS secure 4000 WI

4
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– LECTUS secure 5000 WI
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